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IntuiLink PSA/ESA-E/L/EMC-series Spectrum Analyzer Toolbar in Excel 

What would you like to do? 

 
   Connect to the spectrum analyzer and verify communication 
   Connect to a spectrum analyzer on a remote host  
   Capture the current spectrum analyzer settings  
   Restore previously stored settings to the spectrum analyzer  
   Edit the name of a saved state setting  
   Remove saved state settings 
   Export current spectrum analyzer settings to a PC file  
   Import spectrum analyzer settings from a PC file 
   Get data from the spectrum analyzer   
   Create an Excel graph  
   Start obtaining repeated measurements from the spectrum analyzer  
   Stop obtaining repeated measurements from the spectrum analyzer 
   Get an image of the spectrum analyzer display   
   Delete the spectrum analyzer toolbar from Excel 
   Restore spectrum analyzer  toolbar to Excel 
   Select the toolbar startup options  
   Disconnect from the spectrum analyzer  

 

 Connect to the spectrum analyzer and verify communication 

 

1. Make sure that your spectrum analyzer is physically connected to your computer and 
turned on. 

2. Click Connect to Spectrum Analyzer on the spectrum analyzer toolbar. 

3. Highlight the address from the Select Instrument Address list for the spectrum analyzer 
that you want to connect to. 

Note: 

The instrument addresses listed are for instruments connected to the computer shown under 
the Select Instrument Address list. Look at the label above the Identify Instruments 
button. The name will be either "My Computer" or the name or IP address of a remote host. If 
you want to change the host computer, press the Advanced button and follow the 
instructions in Connect to a spectrum analyzer on a remote host. 
 

4. Click Identify Instrument(s). 

The instrument type, name, and address appear in the Identified Instruments list on the 
right. Instruments supported by the PSA/ESA toolbar are in bold type. 
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Tip: You can double-click on the instrument address and the instruments at that address 
will appear in the Identified Instruments list. 

5. In the Identified Instruments list, highlight the instrument that you want to connect to. 

6. Click Connect. 

A green icon appears to the left of the instrument that is connected. The corresponding 
icon on the toolbar also turns green (after you close the dialog box) to indicate the 
instrument is connected. 

Tip: You can double-click on the instrument to connect to it. 

 

If you do not know the address, you have two options: 
• You can select the address that you think may be correct and click the Identify 

Instrument(s) button to determine the type of instrument at that address.   
OR 
• You can select more than one address (hold down the Shift key while clicking with the 

mouse or hold down the CTRL key while dragging the mouse) and click Identify 
Instrument(s). All the instruments at the selected addresses are listed, with the instruments 
supported by the toolbar in bold. 

 

See the troubleshooting section of the online help if you still cannot connect to the instrument. 

See Also 

Disconnect from a spectrum analyzer  

Connect to a spectrum analyzer on a remote host  

 

 Connect to a spectrum analyzer on a remote host 
(Windows NT or Windows 2000 only) 

 

This procedure assumes that you have already installed the PSA/ESA software on the 
remote host and have a spectrum analyzer connected to the remote computer via GP-IB or 
RS-232. 

1. Click Connect to Spectrum Analyzer on the toolbar. 

2. In the Connect dialog box, click Advanced. 

The Advanced dialog box appears. 

3. Enter the IP address or DNS hostname of the remote computer where the spectrum 
analyzer is connected. 

4. Click Add. The hostname or IP address is now listed in the drop-down box under Select 
Instrument Address By Host: 
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5. From the drop-down box, select the remote host that you want to connect to. 

Note:  

To list only those instruments connected to your computer, select My Computer from the 
drop-down list. 
 

6. Click Close. 

In the Connect dialog box, the addresses for the remote host appear in the Select 
Instrument Address list, and the host name or IP address is displayed just above the 
Advanced button. 

Note: 

Windows 9x does not support remote instantiation of COM server processes. Visit Microsoft’s 
Web site and search for the Knowledge Base article #Q165101 for more detail. 

 

 Capture the current spectrum analyzer settings 

 

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar. 

2. Click Capture New … to capture the current spectrum analyzer state settings.  

The Capture New State dialog box appears. 

3. Enter a name for the state settings. 

4. Enter a description (optional). 

5. Click OK. The information appears in the list in the Capture/Restore Settings dialog box. 

 

Note: The instrument state settings are saved in the document. 

See Also 

Restore previously captured settings to the spectrum analyzer  

Export spectrum analyzer settings to a PC file  

 

 Restore previously captured settings to the spectrum analyzer 

 

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar. 
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2. From the list in the Capture/Restore dialog box, select the name of the state settings that 
you previously captured. 

3. Click Restore. 

4. Check the screen on the spectrum analyzer to verify that the settings were restored. 

State settings are not tracked between work sessions. Therefore, when you exit this work 
session and start the software again, the state settings that you restored in this work session 
will no longer be in effect. 

Note:   

You cannot restore state settings to a different model of spectrum analyzer than was used to 
create the original settings file.  

See Also 

Capture the current spectrum analyzer settings  

Import spectrum analyzer settings from a PC file  

 Edit the name of a saved state setting 

 

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar. 

2. From the list in the Capture/Restore dialog box, select the name of the saved state 
settings that you want to edit. 

3. Click Edit Name. 

4. Type in the new name for the saved state setting. 

See Also 

Export spectrum analyzer settings to a PC file 

Remove saved state settings  

 Remove saved state settings 

 

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar. 

2. From the list in the Capture/Restore dialog box, select the name of the saved state 
settings that you want to remove. 

3. Click Remove. 

The state settings are deleted and are no longer available. 

See Also 

Export spectrum analyzer settings to a PC file 
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 Export spectrum analyzer settings to a PC file 

 

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar. 

2. From the list in the Capture/Restore dialog box, select the name of the state settings that 
you previously captured. 

3. Click Export. 

4. Navigate to the desired directory on your PC and enter a file name, with the file extension 
.sta. 

5. Click Save to store the file. 

The file is now saved outside of the toolbar program. Settings are saved automatically within 
the document by using the capture feature. 

See Also 

Import spectrum analyzer settings from a PC file  

Capture the current spectrum analyzer state settings  

 

 Import spectrum analyzer settings from a PC file 

 

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar. 

2. Click Import. 

3. Navigate to the desired directory on your PC and select the previously stored state setting 
file (.sta file extension).  

4. Click Open to open the file and download the stored settings to the spectrum analyzer. 

5. From the list in the Capture/Restore dialog box, select the state setting that you just 
imported. 

6. Click Restore to restore these settings. 

Note:  

You cannot import the settings to a different model of spectrum analyzer than was used to 
create the original settings file. 

You can import files generated with the Agilent Technologies IntuiLink Spectrum Analyzer 
product (E4444A). 

See Also 

Export spectrum analyzer settings to a PC file  
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 Get data from the spectrum analyzer 

 

1. Click Get Data on the spectrum analyzer toolbar. 

2. In the Labels list, select the desired annotations for the data. 

3. Click the Make Excel Graph checkbox if you want to automatically create a graph of the 
data, in addition to collecting the data in tabular format. 

4. Click the Include Engineering Units checkbox if you want to display data using 
engineering units. 

5. In the Start Cell box, enter the starting cell where you want the information to be placed. If 
you leave this box blank, the default starting cell will be where your cursor was placed 
when you selected the Get Data button on the toolbar. 

6. If you want to get repeated measurements of the data, click the Get Repeated 
Measurements checkbox. Then see Start obtaining repeated measurements from the 
spectrum analyzer. 

7. Click Get Data when you are ready to obtain the data. 

See Also 

Start obtaining repeated measurements from the spectrum analyzer  

Create an Excel graph  

 

 Create an Excel graph 

 

If you have previously collected data in a tabular format in a worksheet and now want to turn 
that data into a graph, follow these steps: 

 

1. In your worksheet, select the cells that you want to use to create a graph. 

2. In the Excel toolbar, click on the Chart Wizard. 

3. Follow the instructions in the Chart Wizard. 

 

 Start obtaining repeated measurements from the spectrum analyzer 

 

1. Click Get Data on the spectrum analyzer toolbar. 
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2. In the Labels list, select the desired annotations for the data. 

3. Uncheck the Make Excel Graph checkbox if you do not want to automatically create a 
graph of the data. 

4. Click the Include Engineering Units checkbox if you want to display data using 
engineering units. 

5. In the Start Cell box, enter the starting cell where you want the information to be placed. If 
you leave this box blank, the default starting cell will be where your Excel cursor was 
placed when you selected the Get Data button on the toolbar. 

6. Click the Get Repeated Measurements checkbox.  

7. Click the Repeated Measurements…. button. 

The Repeated Measurements dialog box appears. 

8. In the Repeated Measurements dialog box, specify the time you want the measurements 
to start.  

Click Immediately if you want the measurements to start right away. 

Click At set time to specify a time to start. If you chose At set time, enter the date and 
time you want the measurements to start. 

9. Specify the time interval at which you want the data collected. For example, if you want to 
collect data every 1 ½  hours, enter 1 in the hours box, 30 in the minutes box, and leave 
the seconds box blank. 

10. To have the collection last for a specified length of time, click Duration and enter the 
hours, minutes, and seconds that you want the collection to last. 

11. Alternatively, to have the collection last for a specific number of measurements, click 
Number of measurements and enter the number of measurements that you want. 

12. Click OK when you are finished. 

The Get Data dialog box now shows the conditions that you have set for collecting 
repeated measurements. 

13. Click Get Data to start the collection. 

Note: 

Once you have started collecting repeated measurements, the other functions of the 
PSA/ESA  toolbar become inactive, with the exception of the Stop Repeated Measurements 
button. You must stop collecting repeated measurements before you can perform any other 
functions from the toolbar. If you press the Stop Repeated Measurements button while data 
is being transferred, the transfer will not stop until the worksheet is complete. 

See Also 

Stop obtaining repeated measurements from the spectrum analyzer  

 



 8 

 Stop obtaining repeated measurements from the spectrum analyzer 

 

To stop obtaining repeated measurements: 

1. Click Stop Repeated Measurements on the spectrum analyzer toolbar. 

If this button is unavailable, there are no repeated measurements being obtained. 

Note: 

You can click Stop Repeated Measurements at any time while repeated measurements are 
being gathered. If you click this button between collection intervals, the data transfer will stop 
immediately. If you click this button while data is being gathered, the data transfer will not 
stop until the worksheet in progress has been completed.  

 

See Also 

Start obtaining repeated measurements from the spectrum analyzer  

 

 Get an image of the spectrum analyzer display 

 

1. Place your cursor in the spreadsheet where you want the image to be displayed. 

2. Click Get Screen Image on the spectrum analyzer. 

3. Click Place in Active Document at cursor (the default) to place the image in the current 
document. An image of the current spectrum analyzer display is placed in the spreadsheet 
in the active cell. If the active cell is not available (for example, your cursor is in a cell that 
has data in it) the image will be placed starting at cell A1. 

OR 

Click Save to File to save the image to a file.   

4. If you Save to File, navigate to the directory in which you want to place the file. 

5. Specify a file format, either .bmp, .wmf, .gif, jpg, .emf, or .tif. 

6. Click Save. 

Note:  

Depending on the type of instrument connection, there may be up to a 10 second delay while 
the picture transfers from the instrument. 

Delete the spectrum analyzer toolbar from Excel 
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If you want to delete the spectrum analyzer toolbar from the current Excel session, follow 
these directions. 

 

1. From the Tools menu in Excel, select Add-Ins. 

2. Clear the check box next to 'ESA Spectrum Analyzer Add-in’.  Make sure that the box is 
not checked. 

3. Click OK to delete the toolbar. 

 

Alternatively, you can just hide the toolbar. 

1. From the View menu in Excel, select Toolbars. 

2. Uncheck the box next to ‘ESA Spectrum Analyzer’. 

Note:   

When you first install the software, the spectrum analyzer toolbar is automatically loaded 
each time you start Excel.  

See Also 

Restore the toolbar to Excel  

Select the toolbar startup options  

 

 

Restore the spectrum analyzer toolbar to Excel 

 

If you want to restore the spectrum analyzer toolbar to the current Excel session, follow these 
directions. 

 

1. From the Tools menu in Excel, select Add-Ins. 

2. Check the box next to 'ESA Spectrum Analyzer Add-in’. 

3. Click OK to restore the toolbar. 

 

Or if you have just hidden the toolbar: 

1. From the View menu in Excel, select Toolbars. 

2. Check the box next to ‘ESA Spectrum Analyzer’. 

Note:   
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When you first install the software, the spectrum analyzer toolbar is automatically loaded 
each time you start Excel.  

See Also 

Delete the toolbar from Excel  

Select the toolbar startup options  

 

Select the toolbar startup options 

 

When you first install the software, the spectrum analyzer toolbar is automatically loaded 
each time you start Excel.  

Remove toolbar at startup 

To prevent the toolbar from loading each time you start Excel: 

1. Locate the file named 'ESA.xla' in the following directory: 
\ Program  Files \ Microsoft  Office \ Office \ Startup 

2. Select the above file, click the right mouse button, and then select Delete. 

Restore toolbar at startup 

If  you have disabled automatic loading of the toolbar and now want to re-enable the feature, 
follow the steps below:  

1. Locate the shortcut file named 'ESA.xla' in the following directory: 
\ Program  Files \ Agilent \ IntuiLink \  ESA 

2. Select the above file, click the right mouse button, then select Create Shortcut. 

3. Move the shortcut copy of the file to the Microsoft Office Startup folder: 
\ Program  Files \ Microsoft  Office \ Office \ Startup 
 

 Disconnect from the spectrum analyzer 

 

On many computers, the COM port is alternately shared by several peripheral devices. The 
Disconnect feature allows you to terminate your current connection to a spectrum analyzer 
without exiting the PSA/ESA E/L/EMC software, freeing up the COM port. 

 

1. Click Connect to Spectrum Analyzer on the toolbar. 

If you are currently connected to a spectrum analyzer, the Disconnect button will be 
available. If you are not connected, the button is grayed out. 

2. Click the Disconnect button in the Connect dialog box.. 
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The current spectrum analyzer connection is terminated. 

Note: 

Connecting to a different spectrum analyzer will disconnect you from the current instrument. 
You can be connected to only one instrument at a time. 

Connect to Spectrum Analyzer 

 

In this dialog box, you specify the spectrum analyzer to which you want to connect. 

Prerequisite 

Make sure that your spectrum analyzer is physically connected to your computer and turned 
on. 

Procedure 

1. Highlight the address from the Select Instrument Address list for the spectrum analyzer 
that you want to connect to. 

Note: 

The instrument addresses listed are for instruments connected to the computer shown under 
the Select Instrument Address list. The name will be either "My Computer" or the name or 
IP address of a remote host. If you want to change the host computer, press the Advanced 
button and follow the instructions below under "To connect to an instrument on a remote 
computer". 
 

2. Click Identify Instrument(s).  

The instrument type, name, and address appear in the Identified Instruments list on the 
right. Instruments supported by the software are in bold type. 

Tip: You can double-click on the instrument address and the instruments at that address 
will appear in the Identified Instruments list. 

3. In the Identified Instruments list, highlight the instrument that you want to connect to. 

4. Click Connect. 

A green icon appears to the left of the instrument that is connected. The corresponding 
icon on the toolbar also turns green (after you close the dialog box)  to indicate the 
instrument is connected. 

Tip: You can double-click on the instrument to connect to it. 

 

If you do not know the address of the spectrum analyzer: 
• Select the address you think may be correct and click Identify Instrument(s) to determine 

the type of instrument at that address.   
OR 
• Select more than one address (hold down the Shift key while clicking with the mouse or 

hold down the CTRL key while dragging the mouse) and click Identify Instrument(s). All 
the instruments at the selected addresses are listed, with the instruments supported by the 
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toolbar in bold. 

 

See the troubleshooting section of the online help if you still cannot connect to the instrument. 

To disconnect from a spectrum analyzer: 

If you are currently connected to a spectrum analyzer, the Disconnect button will be 
available. If you are not connected, the button is grayed out. 

1. Click Disconnect. 

The current spectrum analyzer connection is terminated. 

To connect to an instrument on a remote computer (Windows NT or Windows 2000 only): 

This procedure assumes that you have already installed the PSA/ESA software on the 
remote computer and have a spectrum analyzer connected to the remote computer via GP-IB 
or RS-232. 

1. Click Advanced. 

The Advanced dialog box appears. 

2. Enter the IP address or DNS hostname of the remote computer. 

3. Click Add. The hostname or IP address is now listed in the drop-down box under Select 
Instrument Address By Host: 

4. From the drop-down box, select the remote host that you want to connect to. 

Note: 

To list only those instruments connected to your computer, select My Computer from the 
drop-down list. 
 

5. Click Close. 

In the Connect dialog box, the addresses for the remote host appear in the Select 
Instrument Address list, and the host name or IP address is displayed just above the 
Advanced button. 

Note: 

Windows 9x does not support remote instantiation of COM server processes. Visit Microsoft’s 
Web site and search for the Knowledge Base article #Q165101 for more detail. 

 

 


